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I rxif Print

This printer supports Exif 2.2 (also called “Exif Print”).

Exif Print is a standard for enhancing the communication between digital cameras and printers. By
connecting to an Exif Print-compliant digital camera, the camera’s image data at the time of shooting is
used and optimized, yielding extremely high quality prints.

I Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital
apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus,”
ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB-003 d'Industrie
Canada intitulée « Appareils numériques ».

I 11 tcrnational ENERGY STAR® Program

As an ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY
STAR guidelines for efficiency.

The International ENERGY STAR® Office Equipment Program is a global program
/\ that promotes energy saving through the use of computer and other office equipment.
W The program backs the development and dissemination of products with functions
that effectively reduce energy consumption. It is an open system in which business
can participate voluntarily. The targeted products are office equipment such as com-
puters, monitors, printers, faxes and copiers.
Their standards and logos are uniform among participating nations.

I rovver Requirements

Never use a power supply voltage other than that supplied in the country of purchase. Using the incor-
rect voltage could cause a fire or electric shock. The correct power supply voltages and frequencies are
as follows:

AC 100-127V, 50/60Hz
AC 220-240V, 50/60Hz

Printer Model: K10228 (i350/i250)



Preface
Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact your Canon
Authorized Dealer or Sales Representative.

U Printer

U Setup Software & User’s Guide CD-ROM

O Quick Start Guide

U Print Head

U 2 Ink Tanks

* A USB cable should be purchased separately according to your computer. For details on cable
specifications, refer to page 6.

Introduction

This Quick Start Guide uses the following symbols to indicate important information. Always observe the
instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to avoid
personal injury or damage to the printer.

Notice

The diagrams and computer screens in this guide refer to the i350. The operations are exactly the same
with the 1250.

e
Trademark Notices

+ Canon® is a registered trademark of Canon Inc.

+ Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the U.S. and other
countries.

* Apple, Mac, Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries.

 All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of
their respective owners.

Copyright ©2003 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever
\without the express written permission.




Setting Up

1 Preparing the Printer
Place the printer on a flat surface.

Remove the tape from the printer as
shown.

The tape position is subject to change.

Pull out the output tray and remove the tape as shown
(for 1350 only).

3 Open the front cover and remove the
tape and the shipping material.




2 Installing the Print Head

B Installing the Print Head

lock lever

1 Raise the lock lever.

Do not touch internal parts other than the lock lever.

2 Remove the protective cap from the

print head.
= Notes print head electrical
« Do not touch the print ~ nozzles contacts

head nozzles or
electrical contacts.

* Do not attempt to
reattach the protective
cap once it has been
removed.

3 Place the print head in the holder.

4 Lock the print head into place by
lowering the lever.

Do not touch the lock lever once the print head has been
installed.




B Installing the Ink Tanks

* For safety reasons, store ink tanks out of the reach of small children.
* Do not drop or shake ink tanks as this may cause the ink to leak out and stain your clothes and hands.

1 Take out the black ink tank.

protective cap 2 Hold the ink tank as shown in the
diagram and remove the protective cap.

= Notes

* Do not touch the ink port.

* Do not attempt to reattach the
protective cap once it has
been removed.

Insert the black ink tank into the right-
hand slot.

Press the tab until it clicks into place.

Use the same procedure to install the
color ink tank in the left hand slot.

Close the front cover.




= Note
If an ink tank is installed improperly, the warning message appears when you try to print. Follow the
above instructions in Steps 3 to 6 to reinstall ink tanks.

© Canoni350 - USB0O2 CoX

Option_Help

Piner St |

[An ik tark is not nstald praperb.

Open the font cove of the piter, make
sure the ink tark s insalled properly. and
close the frot cover,

W .

Prining Pages:

Easy Ik Delive| Display Prnt Quee




3 Connecting the Printer to the Computer
Use a USB cable.

Recommended: Canon or other computer manufacturer cable, up to 5 meters in length.

» Never attempt to plug the power cord into the power outlet or unplug the power cord when your
hands are wet.

+ Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy
objects on the power cord.

» Never use any power supply other than the standard power supply available in the country of
purchase. Using the incorrect voltage and frequency could cause a fire or electric shock.

 Always push the plug all the way into the power outlet.

= Notes

* If your computer has an earth connection, make sure that this is attached.
« If you do not intend to use the printer for a long period of time, unplug the power cord from the
power outlet after turning off the printer.

Follow the steps below to install the printer driver

correctly.
1 Ensure the printer and the computer are
switched off.

2 Plug the printer in.
3 Connect the USB cable.

= Note

If the Add New Hardware Wizard or Found New Hardware
Wizard screen appears when carrying out the following tararo Wizard
operations, click Cancel and turn off the computer. (NS .. "

‘Welcome to the Found New
Hardware Wizard




4 Loading Paper

B Loading Plain Paper

Pull out the paper rest and the output
tray (for i350 only) as shown.

Be careful not to jam your finger in the circular holes of
the paper rest (for 1350 only).

To avoid paper jams, fan the stack to
remove static cling, then align the edges
of the stack by tapping it on a flat
surface.

Load the paper, aligning it with the right
side of the sheet feeder.
You can load up to 100 sheets of plain paper. Do not

exceed this limit. For Legal size paper, you can load up
to 10 sheets.

Pinch the paper guide and slide it
against the left side of the stack of

paper.

You now need to install the printer driver:

Windows: Go to page 8
Mac OS 8.6-9.x:  Go to page 10
Mac OS X: Go to page 11




5 Installing the Printer Driver

B Installing the Printer Driver - Windows

= Notes

Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be
correctly installed.

The screens below refer to Windows XP installation. Screen may differ depending on the operating
system you are using.

When installing the printer driver in Windows XP or Windows 2000, log on to the system as a
member of the Administrators group.

The Setup Software & User’s Guide CD-ROM contains the application software. If you want to
install the application software, click Install on step 7. Internet Explorer 4.0 or later must be
installed for Easy-PhotoPrint.

If the following screen appears automatically, click Cancel and follow steps 1 to 8 to install the printer
driver.

‘Welcome to the Found New
Hardware Wizard

Cannot Install this Hardware

This wizard helps you nstal software for The harduare was nat nstaled because the wizard cannatfind

.
v oo oo
(2), 1 your hardware came with an nstallaion €D
2 or Hloppy disk. insert it now.
) ok Bk g vl i such s
i oo e e e

upport Center for futher

Special Notes for Windows 98 or Windows Me USB Users

Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable
connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.



3 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

SN « If the CD-ROM does not run automatically, click

Start and select My Computer, then double-click
the CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language selection screen appears, select a
language, then click the Next button.

canon |

4 Follow the instructions displayed on
Readme )
\| : — screen. When the screen shown on the
— left is displayed, click Install.

Application

Documentation §

5 When the screen shown on the left
appears, turn the printer on.

e If the printer is recognized, the printer driver will be
i automatically installed.

farual Selectian

= Note
ETETTN If the connection is not recognized, refer to the
B section “Notes on Handling the USB Interface (for

Windows Users)” on page 22.

Terminate Installation 6 CIiCk OK.

Software installation is campleted.

Before you use the printer, you must carry out print head
alignment on page 13.

Irstallation results are a3 follows,

Pririter Driver Installed




7 If you want to install the application

Selsct which sotnaa

Canon :
1 software, click Install.
P e Pp— Follow the instructions on screen to install the
skl . application software. When the message “Software

installation is completed.” appears, click OK.

() . .
( i J) o 8 Click Exit.
= Notes

* To view the User’s Guide, refer to “How to View the User’s Guide” on page 22.
+ If a message prompting you to restart the computer appears, click Yes.
* For further information of applications, refer to “Applications Included in the CD-ROM Package”

on page 23.

Application

Documentation

M Installing the Printer Driver — Macintosh

= Notes

* Do not remove or insert the USB cable during installation, as this may result in the computer or
printer not operating normally.

* Before installing the driver, disable all virus detection programs and automatically loading
programs or remove them from your system folder.

* The Setup Software & User’s Guide CD-ROM contains the application software, Easy-PhotoPrint,
to import and print image data. If you want to install Easy-PhotoPrint, double-click the application
folder, then double-click the Easy-PhotoPrint folder and then Installer.

For Mac OS 8.6-9.x Users

] [E canoN_BI HE
8 3 terns, 2.5 MB available 1 Turn on the Mac
%) N v 2 Place the Setup Software & User’s
— Guide CD-ROM in the CD-ROM drive.
|:| [ Mac 05 8.6-9.x =)=
dliic el 3 Double-click the Mac OS 8.6-9.x folder.
. L 4 Double-click the Printer Driver folder,
Printer Driver, Application (=]
. then select a language.
I:I [ Printer Driver =]
2 items, 2.5 MB available .
5 Double-click Installer.
‘ B
Installer Read Me B
oy
6 Read the License Agreement and click
Accept to continue.

10



|
m|

& Installation was successful. You have installed
software which requires you to restart your
computer. Ifyou are finished, click Restart, or ifyou

wish to perform additional installations, click
Continue.

(Continue ([ Testere ]

U2 File Edit View Window Special Help

About This Computer

4D Apple System Profiler
=

Key Caps
Network Browser
G Recent Applications  p

Connected to =
oy [

5 6000 Series ||
rESaGerver) Backgrounding
> || e
=] ® Active
msstServer) || | AppleTali
©Q Inactive 162
800 5 CANON_B) =)

Mac 05 8.6-9.x Mac 05 X Manual

7 Click Install.

Wait for the installation to finish.

= Note

No other applications can be running during

@ this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

(concer ] ([

If the above message appears, check that there are
no unsaved documents, then click the Continue
button. If a document needs to be saved, click
Cancel then save the document. After saving the
document, begin again from step 4.

8 Click Restart.

The computer restarts.
9 Turn the printer on.

10 Select Chooser in the Apple Menu.

11 Click the icon for the printer you are
using and close Chooser.

Before you use the printer, you must carry out print head
alignment on page 15.

For Mac OS X Users
1 Turn on the Mac.

2 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

3 Double-click the Mac OS X folder, then
double-click the Printer Driver folder.

11



‘eee Printer Driver =
% T atable

1350 190.pkg

Deutsch English Espafiol

Frangals Mtaliano Nederlands

c
BY INSTALLING THE PRINTER DRIVER FOR BUBBLE-JET PRINTER
(THE "SOFTWARE"), YOU ARE DEEMED TO AGREE TO BE BOUND

THE TERMS OF THIS AGREEMENT, DO NOT INSTALL THE

SOFTWARE AND PROMPTLY RETURN THE CANON DISK TO THE
PLACE WHERE YOU OBTAINED IT FOR A REFUND BEFORE THEY
ARE USED.

) (e ) (Goma) (Comme)

e Install 8 printer driver

Easy Install

Click Upgrade to perform a basic installation of this
software package.

e Install B) printer driver

Install Software

The software was successfully installed

Click Restart t

shinstalling the software.

€ Restart )

12

4 Double-click i350 190.pkg or i250
190.pkg.

5 Enter an administrator name and a
password, then click OK.

6 Click Continue.

7 Read the License Agreement and click
Continue, then click Agree.

8 Select a destination to where you want
to install the printer driver, and click
Continue.

9 Click Install.

10 A message asking for your confirmation
to restart your computer appears on the
screen. Read the message, then click
Continue Installation.

Software installation will start.

11 Software installation is complete.
Restart your computer and turn the
printer on.

Before you use the printer, you must carry out print head
alignment. For instructions on how to align the print
head, refer to the Printer Driver Guide for Mac OS X. To
view the Printer Driver Guide for Mac OS X, double-
click the Manual folder and Additional Guide for OS
X User’s folder and select the language folder that you
use.

You can also refer to the Printer Driver Guide for Mac
OS X for instructions on how to use the printer driver.



6 Aligning the Print Head

This operation must be carried out when using the printer for the first time. Aligning the print head positions
allows you to print without shifts in the color registration.

B Aligning the Print Head — Windows

1 Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-XP Windows, click Start, then select
Settings, Printers.

2 Click the icon for your printer.

3 Open the File menu and select:

* Windows XP/Windows 2000 —
[Printing Preferences...]
* Windows Me/Windows 98 —[Properties]

to open the setting screen.

Canon 1350 X 4 Click OK.

) This printer requires print head alignment.
Click Print Head Alignment on the Maintenance tab to start aignment.

5 Click the Maintenance tab, and click
Print Head Alignment.

13



Print Head Alipnment E|E\

Print head alignment s being sxecuted. Referiing ta the pattems
printed in columns A ta F, select the patter that shaws o flaws,

Harizontal Alignmept [3 to +7)
CoumnB: |0 —

&

d

CoumnC: [0 -
Bidirectional Alignment 5 to +5]
CoumnD: [0 =]
CoumnE [0 =]
CoumnE: [0 -]
[ o ] conce ‘ Help |

Print Head Alignment ['EI@

Fiint head agnment s being executed. Rieferiing to the pattems
printed in columns & ta F, sslect the patter that shows na faws

Horizontal Alignment (-3 to +7]

Colurn &

Column B:

Column C

Bi-directiong)é

Zolumn E;

Column E:

Cancel

Canon i350

.
\l)) Frint head alignrent is now complete,
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Check that paper is loaded in the printer
and click OK. If a message warning you
not to perform other operations
appears, click OK.

It takes about 60 seconds to start printing.
After the pattern is printed, click Yes.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.

In the same way, one by one, select the
most even patterns printed with the
least irregularities from each of
Columns B to F, enter their numbers,
and click OK.

If it is difficult to pick the best pattern on Column F, pick
the setting that produces the least noticeable vertical
white stripes.

Less noticeable
white stripes

More noticeable
white stripes

10 Click OK.

This completes the printer setup. The printer is now
ready to use.



B Aligning the Print Head — Macintosh

= Note

For Mac OS X users, refer to the Printer Driver Guide for Mac OS X for instructions on how to align

the print head.

canoni350 Version44

Canon 350 Printer Utility Version 44

TestPrint )

B Nozzle Check
Prints a nozzle-check pattern.
(i) [) Princ Head Atignment
Itwill align the print heads to correct any

errorin their installation position.

[

H

Print head alignment is being executed.
Alignment entails printing, so do the
following: Ready the printer (connectthe
cable and turn the power on),and load a
sheet of plain paperin the sheetfeeder.
Do you want to print head alignment
patterns?

e ()

Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns A to F, select the pattern that shows no flaws.

Adjust sideways (-3~+

-

- ColumnA: o g

E ColumnB:

@ Column €

= Adjust both ways (-5~+5)
Column D:
ColumnE:
Column F:

Select Page Setup in the File Menu.
Click Utilities.

Select Test Print from the menu and
click Print Head Alignment.

Check that paper is loaded in the printer
and click OK.

It takes about 60 seconds to start printing.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.

15



Print Head Alignment

Print head alignment is being executed. Referring to the patterns
printed in columns Ato F, select the pattern that shows no flaws.

= Adjust sideways(-3-+7)
- Column A:
=
= Column B:
=
= Column C:
=
- Adjust both ways(-5~+]
Column D:
ColumnE:
Column F:
Canon i350 Printer Utility Version 4.4
Test Print 3
| tozste ec
Prints a nozzle-check pattern.
@ Print Head Alignment
It will align the print heads to correct any
errorin theirinstallation position.
Canoni3s0 Version:
1 [13
Paper size: (AT z
rintin

16

6

In the same way, one by one, select the
most even patterns printed with the
least irregularities from each of
Columns B to F, enter their numbers
and click Send.

If it is difficult to pick the best pattern on Column F, pick
the setting that produces the least noticeable vertical
white stripes.

Less noticeable
white stripes

More noticeable
white stripes

7 Click Close.

8 Click OK.

This completes the printer setup. The printer is now
ready to use.



Basic Operations

+ Ifyou detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and always unplug the printer. Contact your local Canon service representative.
* To avoid injury, never put your hand or fingers inside the printer while it is printing.

Printing with Windows
Adjusting the print settings according to your needs allows you to produce better quality prints.

In this section, we will use WordPad for the purpose of explanation. The procedures you use and the screens
that appear on your computer may differ according to the application that you use.

B Printing

1 Print the document from the application.

Hew Chrlh

Open. o On the File menu, click Print.

Save ctri+s

Check the application’s users manual for the actual
procedures.

T R% 2 Ensure your printer is selected, then
s click:

* Windows XP —[Preferences]
* Windows Me/Windows 98 —{Properties]
* Windows 2000 —{Main] tab

3 Specify the required settings and click

D Main | Page Setup| @ Stemp/Backgiound | o Effects | (3 Profiles | 8) Maintenance o K
=t (o
@ om™ = Note
O Custom
it O If you use anything other than plain paper, please
i

refer to “Basic Print Settings” on page 18.

s

4 To start printing, click OK.

Printing will start in a few moments.

17



B Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Main tab. To get the
best results, ensure you select the type of media loaded in the printer when printing on paper other

than plain paper.

& Canon i35 Printing Preferences [ ; (6)

) Main @ Page Setup | @] Stamp/Background | ¢# Effects ﬁ Profiles m Maintenance

Caolor Printing
258 Plain Paper

~
Media Type: QF‘Iain Paper 9‘ (1 )
Paper Source: ‘Aum Sheet Feeder j
Pk Qualiy T High 3
_ * Standard (2)
L | Dyalt
" Custom )
Color Adjustment: & Auto \ 3
" Manual J ( )

™ Grayscale Printing

' [ Preview before printing ) (4)

About Defaults
C= (5)

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Color Adjustment

If you wish to control the color adjustment settings in more detail,
select Manual.

(4) Preview before printing

Select this to check the layout before printing.

(5) Help

Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows XP or Windows 2000. If
this happens, click Start then select All Programs (or Programs) -
Canon i350 or Canon i250 - Guide).

(6)?

Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

= Notes

* Clicking the Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

+ Use the application to set the paper size and paper orientation. Before printing, open the settings
screen and check that the Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User’s Guide for more information about printer driver functionality.

18



Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing

3 [f1CW Edit Font Size S5Style Sound He
New BN PV——"rpo2—i—unt

Close B/W
Save 285
Save As

Page Setup... .

Print One Copy
Quit D)

canoniiso Version 44

" & IGTH dit Font Size Style Sound Hel
New BN
Open.. 20
Close BW
Save 31
Save As...

Page Setup...
Print.. %P .
Print One Copy

Quit %0

1 Open the Page Setup dialog box in

your application.

On the File menu, click Page Setup. Check the
application’s users manual for the actual procedures.

Specify the page setup.

For details, refer to “Page Setup” on page 20.

Open the Print dialog box in your
application to print the document.

On the File menu, click Print. Check the application’s
users manual for the actual procedures.

Specify the print settings according to
your requirements.

For details, refer to “Basic Print Settings” on page 20.

Click Print.

Printing will start in a few moments.

19



B Page Setup

Use the Page Setup dialog box to specify the paper size settings.

‘Canoni3so

Version 44

0K
paper Size(: [A4 ﬂ\
Cancel
[J Borderless Printing
Amount of Extension :
Min. e Max.

Height: 207.0mm

scale:  [100 |[F] %
Orientation :

Whidth :210.0mm

[ Save Settings

B Basic Print Settings

Select paper size
you wish to use.

For the best print quality, specify the minimum requirement settings in the Print dialog box. To get
the best results, ensure you select the type of media loaded in the printer when printing on paper

other than plain paper.
‘Canen i350 Version 4.4
(
Copies
e [
Pages . @ all
Options...
arom [ ] [
i
L BJ Cartridge
ey [Catar B]
" ediaTig
= ~
e ([Plam Paper )
i 7
TS
Auto Feed 2
Letter [n - ?Mei o J
Normal-size printing ~
[Text S H—E—
Grayscale Printing

©)

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Select the type of document you want to print.

To specify more detailed settings for the print quality or color, select

Manual and click Details.

(3) Print

Click this to start printing.

= Notes

See Balloon Help for more information about other printer driver functions.

Select Show Balloons in the Help menu for an explanation of each of the items in the setting
screen. To see the explanation, point to the item with the mouse.

Refer to the User’s Guide for more information about printer driver functionality.

20



Print Head Maintenance

B If Blurring Occurs or If a Specific Color Does Not Print

Perform print head cleaning to improve the print quality. Ensure that the printer is turned on and
follow the instructions below.

* Windows
Open the printer driver settings screen and click the Maintenance tab. Click Cleaning.
See page 13 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click Utilities. Click Cleaning.

B When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Ink Tank BCI-24 Color
Ink Tank BCI-24 Black

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

2 Install the new ink tank.

Close the front cover when finished.

= Note

When you enable the low ink warning, reset the ink
counter of the ink tank installed.

Refer to the User’s Guide for more detailed
procedures and information about maintenance.

21



Appendix

Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a
problem with the USB driver installation.
Try reinstalling the printer driver.

B Reinstalling
If you cannot proceed beyond the Printer Port screen:

Click Cancel.

When the Terminate Installation screen is
displayed, click OK.

Click Exit, then remove the CD-ROM.
Turn the printer off.

Restart the computer.

A AW N =

Reinstall the printer driver (see page 8).

For Further Details...
For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

B User’s Guide Contents

The “User’s Guide” is HTML manual you can browse through on your computer.

Contents

* Printer parts and their functions * Printing media

* Further printing techniques * Troubleshooting
* Routine maintenance * Specifications

B How to View the User’s Guide

For Windows For Mac OS 8.6-9.x
(1) Load the CD-ROM in your computer. (1) Load the CD-ROM in your computer.
(2) Click Documentation at left of the screen. (2) Double-click the Manual folder.
(3) Click View Documents. (3) Select a language folder.
(4) When a message appears, click (4) Double-click the User's Guide folder.
* Yes — to install the User’s Guide (5) Double-click the icon for the
* No — only to browse the User’s Guide i350&i250 UG_ENGhtm file.

(5) Select User’s Guide and click OK.
Follow the instructions on screen.

22



B Applications Included in the CD-ROM Package

Easy-PhotoPrint (Windows/Macintosh)

You can make a Borderless Printing (1350 only) easily and quickly, just by selecting a photograph taken with
a digital camera and the paper type on which to print. You can also use simple editing features such as
trimming and image rotation.

It is Exif Print (Exif 2.2) compatible.

Easy-WebPrint (Windows)

You can easily print homepages displayed on Internet Explorer or pages from User’s Guide (HTML manual
of this printer) in full size.

Easy-WebPrint automatically adjusts the layout when printing a screen.

This feature enables you to print a screen without its right end being cut.

This application is a plug-in for Internet Explorer, and its toolbar is automatically added to Internet Explorer
after installation. You need Microsoft Internet Explorer 5.5 or later to use this application.

B BJ Printer Driver Systems Requirements

For Windows

» Use a computer equipped on which Windows XP, Windows 2000, Windows Me, or Windows 98
can operate.

+ USB* interface

* CD-ROM drive

* Available hard-disk space for printer driver installation

Windows XP/Windows 2000: 50MB
Windows Me/Windows 98: 15MB

*USB operation can only be guaranteed on a PC with pre-installed Windows XP, Windows 2000,
Windows Me, or Windows 98. (This includes Windows XP, Windows 2000, or Windows Me
upgraded from pre-installed Windows 98 or later)

For Macintosh

» Use a Macintosh series computer equipped with USB interface on which Mac OS 8.6-9.x or
Mac OS X v.10.2.1 or later can operate.

* Available hard-disk space for printer driver installation

Mac OS 8.6-9.x: 30 MB
Mac OS X v.10.2.1 or later: 100 MB
 The following functions are not supported when using Mac OS X v.10.2.1 or later:
- Duplex Printing
- Photo Optimizer Pro

Additional Systems Requirements for User’s Guide

« Pentium® 75 MHz equivalent or higher processor (Pentiurn® 133MHz equivalent or higher
processor recommended)

 2x or higher CD-ROM drive (4x or higher recommended)

* 10 MB of available hard-disk space (when installing the User’s Guide)

* Microsoft Internet Explorer 5.0 or later
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